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Welcome 
EESy Solutions is a newsletter developed to 
provide news, tips, and tricks relating to 
Engineering Equation Solver.  EESy Solutions is 
provided at no cost to all users of EES. Did you 
miss any of the previous issues? These 
newsletters and other useful information can be 
downloaded from our web site: www.fchart.com.    

 

Instant Update Service 
All new licenses of EES are provided with one 
year of Instant Update Service. Instant Update 
Service is a valuable addition to EES, since it is 
updated frequently.  The latest version is placed 
on our server so that subscribers can download a 
new version whenever they wish to do so.  If 
your current version of EES is 6.907 or newer, 
you can access the Instant Update server 
conveniently with the EES Instant Update menu 
item in the Help menu. The fee to continue 
Instant Update Service after the first year is 25% 
of current cost of the program per year.  Contact 
F-Chart Software or use the web (fchart.com) if 
you wish to subscribe to Instant Update Service 
and take advantage of some of the new features 
described below.    

 
Academic Professional Site Licenses 
The Professional version of EES provides a 
number of important capabilities.  Among the 
most popular are the ability to create animations 
that are controlled by equations and the ability to 
create stand-alone distributable programs.  The 
Professional version provides access to the 
genetic optimization algorithm and allows larger 
problems to be solved.  This issue of EESY 
Solutions will provide information on some of 
these capabilities.  Up until recently, the 
Professional version was not available as a site 
license to academic departments.  This policy has 
been changed.  The Academic/Professional is 
available for a one-time fee of $3,750.  
Departments that currently have an Academic 
license receive a $1,000 credit.   

What’s New? 
As in years past, literally hundreds of changes 
have made to EES during the past year.  The 
capabilities of the program continue to grow. 
What follows is a short description of some of 
the more important new capabilities.  
 
Diagram and Plot Window Animations 
The Professional version of EES provides 
powerful capabilities to animate drawings and 
plots in the Diagram and Plot windows.  Unlike 
many other animation programs that provide 
capability to create animated drawings, EES 
allows the animation to be controlled by 
calculated values.  The animation in the Diagram 
window can thus be accurately displayed.  In 
addition the movements of objects in the 
Diagram window can be directly coupled to 
animations in the plots.  Animations can only be 
created by the Professional version, but once 
created, they can be displayed in any version of 
EES, including academic versions and 
distributable programs.  Animation capability 
adds a new dimension to EES.  We recommend 
that you run some of the examples provided in 
the Animations menu item of the Examples 
menu to appreciate the power of this new 
capability.  Animations are also very easy to 
create, as shown by example in this issue.  
 
Improvements to the Optimization Capabilities 
The most powerful new addition to the 
computational capabilities in EES this year is the 
genetic optimization provided in the Professional 
version.  The genetic optimization algorithm is 
designed to reliably locate a global optimum 
even in the presence of local optima.  The 
robustness of all of the optimization algorithms 
has been increased by providing an option to 
continue calculations, even if an error condition 
is encountered.  Another option that has been 
added is the ability to log results to a disk file so 
that the progress of the optimization process can 
be recorded.  The progress dialog that appears 
during optimization calculations displays both 
the current and the best values of the independent 
variables  
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The genetic method mimics the processes 
occurring in biological evolution.  A population 
of individuals (i.e., sample points) is initially 
chosen at random from the range specified by the 
bounds of the independent variables.  The 
individuals in this population are surveyed to 
determine their fitness (i.e., the values of the 
objective function as quantified by the value of 
the variable that is to be minimized or 
maximized). Then a new generation of 
individuals is generated in a stochastic manner 
by 'breeding' selected members of the current 
population.  The characteristics of an individual 
that are passed on to the next generation are 
represented by encoded values of its independent 
variables.  The probability that an individual in 
the current population will be selected for 
breeding the next generation is an increasing 
function of its fitness.  The 'breeding' combines 
the characteristics of two parents in a stochastic 
manner. Additional random variations are 
introduced by the possibility of 'mutations' for 
which the offspring may have characteristics that 
differ markedly from those of the parents.  The 
current implementation allows the user to control 
the number of individuals in the population, the 
number of generations, and the maximum 
mutation rate.  
 
Property Data 
A distinguishing feature of the EES program is 
its extensive library of fluid property data that is 
coupled with its equation solving capability.  
New property functions, P_sat and T_sat return 
the saturation pressure and temperature, 
respectively, of a fluid without having to specify 
a quality.  The Enthalpy_Fusion function returns 
the enthalpy change of fusion for the specified 
substance at its normal melting temperature.  
Thermodynamic and transport property data have 
been added for R116, R124, Krypton, SF6, 
R143a, n-heptane, n-octane, FC72, and Xenon. 
 
3D Plotting Capability 
3D plotting capability was originally imple-
mented in version 6.394.  It was removed in 
version 6.648 because some video drivers are not 
able to function properly with the 3D plotting 
routines.  The current version allows EES to be 
installed with or without the 3D plotting 
capability by checking the appropriate option in 
the installation program. 

Conditional Compilation 
The $IF/IFNOT directives allow conditional 
inclusion of equations in the Equations window, 
eliminating the need to comment and uncomment 
equations for different situations.  This 
capability, introduced in version 6.685, has been 
extended to include tests for the presence of the 
Diagram window and Integral Table.  The 
$IF/IFNOT directives know whether the solution 
was started by the Solve, Solve Table, or 
Min/Max Table commands and the equations can 
be automatically changed for each situation.  
$IF/IFNOT can also test a string variable and 
change the equations that are to be solved based 
on the contents of the string variable.  The string 
variable can be set with a drop-down selection 
box in the Diagram window.  Examples of this 
powerful capability can be found in the 
Directives menu option of the Help menu.   
 
Solving Selected Parametric Tables 
There is no limit on the number of Parametric 
tables that can be defined, other than available 
memory.  EES formerly allowed a selected table 
or all tables to be solved.  Starting in version 
7.093, the tables that are to be solved with the 
Solve Table command can be selected.   
 
Setting Global Constants 
Constants in EES are identified by a variable 
name that ends with #.  The distinguishing 
characteristics of constants is that they have a 
value and associated units in both the English 
and SI unit system and they are directly 
accessible to the main program and all 
subprograms, functions, and procedures.  EES is 
shipped with a number of predefined constants, 
such as the g#, for gravitational acceleration.  
Additional constants are entered by the user with 
the Constants menu item in the Options menu.  
However, constants entered in that manner are 
permanently stored.  The $Constants directive 
allows constants to be defined just for the 
currently defined problem.  Since constants are 
visible to all EES functions, procedures, 
modules, and subprograms, constants defined 
with the $CONSTANT directive serve as global 
variables within an EES file.  These constants are 
useful for specifying the size of arrays that are 
passed to EES functions and procedures.  
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Macro Command Additions 
The macro command capability in the 
Professional version provides an easy way to 
repeat a series of instructions.  Clicking the Play 
button in the Macro command window will 
replay all of the commands that are displayed.  If 
a Cycle command is included in the macro file, 
the commands in the macro file are repeated for 
a specified number of times or indefinitely, if no 
specification is provided.  Pressing the Esc key 
will stop execution.  A Pause command can be 
included in the macro file so that EES will pause 
for a specified time period between each 
execution of the macro commands. With these 
commands, it is possible to interface EES to a 
data acquisition program that outputs data to a 
file or to the Clipboard at specified time 
intervals. EES can repeat its calculations with 
each new set of data placed in the file or on the 
clipboard. 
 
Saving Tables 
The Save Lookup Table command in the Tables 
menu has been removed.  In its place is the Save 
Table command that allows all EES tables 
(including the Arrays and Integral Tables) to be 
saved in a choice of formats.  This command 
provides a convenient way to export data to EES 
Lookup tables or to other applications. An option 
to transpose rows and columns is also provided. 
 
Peng-Robinson Support Routines 
The Peng-Robinson equation of state cannot 
provide the high accuracy thermodynamic 
property information available with the EES 
built-in property relations.  However, the Peng-
Robinson routines provide a means of estimating 
the thermodynamics properties of fluid mixtures.  
A set of support routines that provide 
compressibility and fugacity factors, for liquid 
and vapor phases, as well as enthalpy and 
entropy departure information are implemented 
in the Peng-Robinson.DLL external library. 
 
Copying Tables with Header Information 
The Copy Table with Headers menu item in the 
Edit menu copies the column name and units, in 
addition to the selected data, to the clipboard. 

Making Distributable Programs 
The Make Distributable command (File menu, 
Professional version) has been modified to allow 
up to 100 files to be included with a 
Distributable program.  The files are accessed 
from a Distributable Files menu that is placed at 
the rightmost position of the menu bar.  The 
name of this menu can be supplied when the 
distributable program is created.  Horizontal 
menu separators can be added by supply a 
hyphen (-) as the file name.  Provisions have 
been added to the Make Distributable command 
to view and reorder the files that are to be 
included in the distributable program.  The 
contents of a .jpg, .wmf, or .bmp graphical file 
can optionally be displayed when a distributable 
program is started.  This file can be used to 
provide author information, a company logo, or 
any desired information.  The contents of the file 
are incorporated into the distributable when it is 
created.  The Make Distributable command 
provides a check list of external files that should 
be included with the Distributable program and a 
..\UserLib subdirectory is automatically created 
if needed.  Also check boxes are now available to 
control access to the Calculate menu, and the 
Solution, Residuals, Arrays, and Integral Table 
menu items for each EES files included in the 
Distributable program.  The Constants.txt file is 
now saved with the Distributable program.  It is 
no longer necessary to provide it separately. 
 
Conveniences 
A Paste Special button is has been placed in the 
upper left cell of the Lookup Tables.  This button 
allows column names and units to be pasted from 
the clipboard, in addition to data in the table.  
 
A Sort button is provided in the upper left corner 
of the Arrays Table. Clicking the Sort button will 
arrange the columns in the Arrays Table into 
alphabetical order.  
 
A column in any of the tables can be moved to a 
new position by dragging its header cell (top 
row) with the left mouse button to a new 
location. 
 



 
 
 
EESy Solutions Page 4 No. 14, Spring 2004 

 

 
F-Chart Software     Phone: (608) 836-8531 
http://www.fChart.com  FAX: (608) 836-8536 

Tips and Tricks 
The animation capability provided in the 
Professional version is powerful and easy to use.  
Follow the instructions below to create an 
animation.   
 
Create a graphical object in the Diagram window 
using the EES drawing tools (accessed from the 
Diagram window toolbar) or by pasting an object 
drawn in another program, e.g., PowerPoint.  The 
latter method is used here.   

  
Right-click on the smiley face object and select 
the Properties menu item from the pop-up menu.    

  
Enter a name, e.g., Smiley, for the object.  The 
attributes of Smiley can now be specified in the 
EES Equations window.  Click the Add 
Calculate Button at the top right of the toolbar 
and select Animation Control bar.   

  
Right click on the animation control bar and 
select the Solve Table button.  Hide the Diagram 
toolbar to put the Diagram window in application 
mode.  
 
Enter the following equation into the Equations 
window.      
Smiley.angle=theta  
Create a Parametric table with 361 rows and 
include variables Smiley.angle and theta.  Fill the 
theta column with numbers between 0 and 360 
by clicking on the triangular control at the upper 
right of the theta column in the Parametric table.   
 
Bring the Diagram window to the front and click 
on the green triangular play button in the 
animation control bar.  Smiley should now be 
turning.    

 
 
Congratulations!  You have just created an EES 
animation.  Hide the Parametric table if you do 
not wish to see it being updated.  Try some of the 
controls in the animation control bar.  The 
buttons allow you to pause, stop, re-start.  The 
loop button will keep the animation going until 
you stop it with the Esc key.  The speed can be 
controlled by the slider bar.  Its fun and EESy.  


